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					Your frequently asked questions – and our solutions

Our technical support team has been asked lots of questions by Allplan users over the years and our solutions have been stored in a knowledge database.

As a Serviceplus customer, you can search the full database for the answers you need.
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			Question:

I want to create a label style or modify a report. Where can I find an overview of available attributes?


Answer:

Open the Allplan Help on the Index tab. Scroll down until you see the Attribute keyword. You can find several entries for attributes. In addition, the Allplan Help provides attribute lists sorted by component.

[image: ]



Note:

You can enter up to 254 characters of text for attributes. However, numerous attributes are limited to 16 characters.
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			Question:

How are the leg lengths and bending dimensions of a pull-out determined for a bar that is not bent at right angles?



Answer:

The leg lengths and dimension lines are calculated in accordance with ISO 3766 (03. 2004). ISO 3766 replaces the previous version
ISO 4066.

The small differences (max. 2 mm according to Fig. 1) result from rounding tolerances

[image: ]

Figure 1: Dimensioning of non-rectangular legs according to ISO 3766 with real iron representation.

[image: ]

Figure 2: Pull-out representation on the plan (bar axis)

[image: ]

Fig. 3: Drawing of a cranked bar according to ISO 3766 with real bar representation. The offset dimension is determined via the two outer edges of the vertical legs.

[image: ]

Figure 4: Pull-out representation on the plan (bar axis)



Hint:

We recommend including corresponding information in the bending stamp to avoid misunderstandings.
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			QUESTION:

 

How can I create or purchase a USER account and a LICENSE for Allplan Exchange?

 

 

 

Answer:
	1) Create USER account via Connect
	2) Purchase a LICENSE from sales partners to use the Exchange online service
	3) Login

 

--------------------------------------------------------------------------------------------------------------

 

1) Create USER account via Connect
	Start Connect= https://connect.allplan.com/register.html
	Follow the self-explanatory steps of the registration function:

[image: image-2023-8-4_12-17-26.png]

 
	The registration worked!
	Register with a valid USER account for all our online services (such as BIMPLUS and EXCHANGE).
	Use is only possible after purchasing a license

 

 

 

2) Purchase a LICENSE from sales partners to use the Exchange online service
	The Exchange Online service can only be used with a license.
	Please contact your sales partner
	LINK = https://www.allplan.com/consulting-sale/addresses-sales-partner/

 

 

 

3) Login

 

You can login after or before purchasing the license.
	Without a license, you can use Allplan Exchange online Service from other company accounts within the scope of the authorizations assigned to you.
	With a license you have your own company account
	Start the Allplan Exchange homepage here and log in: https://exchange.allplan.com

 

[image: LOGIN SSO_ENG_red640 (1).png]

HINT:

 

If you receive these messages in Exchange (Allplan CAD and on the WEB site) after logging in

 

 
	In Allplan CAD – Exchange: "Your user account is not assigned to an organization. It will switch to offline mode.”
	On the WEBSITE -Exchange : INBOX menu= “Your inbox is empty”  || PROJECTS menu = "Your companies, project list is empty, no assignment to a company or project"

[image: No ACCOUNT_ENG_red640.png]


This is because you have a valid USER account for all of our online services, but not a license for your own COMPANY account
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			Task:

You have installed Allplan locally on several workstations and now wish to change the installation to access a shared network drive with the data store.



Note:

Before you switch to a network installation, you must back up the data of all workstations. 
We highly recommend that this work be carried out by a technician. Your sales partner will be happy to provide you with a quote for this.



Solution:

For cases where Allplan is installed locally and the project data is also stored locally on each computer, the following description shows how to change to workstations with a common network drive for common file storage.

1. Getting ready
Choose one of the workstations where you will install all the projects and the office standard (hereinafter referred to as the main workstation). 
First, move all the projects to the main workstation.

1.a: copying resources into projects
To make sure that the projects in your office have a uniform appearance, change the path settings for the projects' resources to 'Project'.
Make the following setting for each project:
Allplan -> File -> ProjectPilot - Admin. -> Select projects individually -> right mouse button -> Properties -> Settings tab
Change the path settings for 'Pen and line definitions', 'Fonts', 'patterns, hatching styles, area styles', 'bar and mesh cross-section catalogs', 'layer structures, line styles, drawing types' and 'attributes proposed' from 'Office' to 'Project', if necessary.
The corresponding elements are copied from the office standard directly to the project. This ensures that the project settings stay the same even when you copy the project to the new server with the new office standard.

1.b: pen color ("Color stands for pen")
The pen color for the "Color stands for pen" setting is a user-specific setting that is not saved to the project but to the user folder (...\Usr).

2.a: Importing projects from individual workstations to the main workstation
The projects of the secondary workstations can now be imported at the main workstation via the tool "New Project, Open Project -> Import project". Here you can import one or more projects or zipped project backups from any path. You can select the projects in the “import project” dialog box and import them into the current version. The source version is displayed in the version column.

The main workstation contains the latest version of all the projects of the office.

3. merging project defaults
To do this, copy the elements to be transferred (symbols, smart symbols, lists, etc.) on the secondary workstations in ProjectPilot to the external path, which can of course be set to a shared network folder.
In a second step, copy the elements to be transferred to the office standard on the main workstation in ProjectPilot via the external path.

4. Transfer the central file storage folder from the main computer to the future server:

	Before the switch, create a folder on the server (e.g. Data) and share this folder with anyone with full access (e.g. as Data). Create a subfolderAllplanunder it. (e.g. \\server\Data\Allplan). Allplan works with UNC path. In the case of a network installation, there must therefore be a folder for the central file storage on which Allplan 2022 is to be installed that is shared by all computers.
1.
	Exit Allplan on all Allplan workstations.
1.
	Open the Allplan Diagnostic Tool on the first computer viaServices application - > Service - > Allplan Diagnostics. Switch to the "Settings" tab.
1.
	Under the field "Workgroup settings” press "Search...". In the browser that appears, you can search for the new share by entering the UNC name of the new server at the top followed by the share or the complete path and confirm with Enter. Select your new central file storage folder and confirm with OK. Please note that the new path must conform to UNC only when using the Workgroup Manager. For example:  \\server\Data\Allplan)
1.
	To start the migration, please press "Apply". This will start the copying process and change the configuration. The data is not moved but copied and this workstation is now converted and accesses the new data store.

	You can now switch all the workstations to the future network installation via the same process. For the other workstations, the copying process of the project and STD folder is prevented with a corresponding note, because the routine already recognizes these folders on the new server. Only the configurations on the computer are changed. 


5. Optional: Activate Workgroup Manager (if the licenses include it)

Please refer to the following FAQ to enable the Workgroup Manager on the workstations:

[image: ]
https://connect.allplan.com/en/faqid/20211001075702.html

6. Summary:
All the workstations access a common network drive with the same project pool and office standard.
Without the Workgroup Manager, only one user can access a project at the same time. Simultaneous work of multiple users in one project is only possible in an Allpan installation with the Workgroup Manager, if the license includes it. Please see section 5.
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			Question:

What graphics cards can be used with Allplan?



Answer:

Generally, the graphics cards of the two large manufacturers - NVIDIA and AMD (ATI) - can be divided into two product lines each:
	Graphics cards designed for CAD (NVIDIA: Quadro / AMD (ATI): Fire)
	Graphics cards designed for other applications (games, office) - "consumer level" (NVIDIA: GeForce / AMD (ATI): Radeon)


The performance and price of the individual product lines and models vary considerably.

In Allplan, the differences in performance become evident in the following situations:
	Graphics engine, a hardware-based graphics accelerator for designing in Allplan, which is important for large volumes of data.
	Animation


Nemetschek Allplan tests current graphics cards and certifies those that can be used with Allplan.
The section that follows provides information on various situations.


	Purchase of new hardware:


You are advised to only consider graphics cards that are designed for CAD.
Allplan Connect helps you find a suitable graphics card. Just follow this link:
https://www.allplan.com/services/cad-software-support/grafikkarten.html

To see whether a specific graphics card can be used, all you need to do is type in its name in the custom box.

	Existing hardware:


To determine whether the entire system you use meets the technical requirements, you can use the system test:
https://www.allplan.com/services/cad-software-support/downloads.html

Explanations of the messages issued for graphics cards:

Warning: The graphics board is a consumer-level card (see log). Although it supports the hardware requirements for ..., it is not optimized for CAD systems.
-> The graphics engine works with this card. Please read the following notes: 
https://connect.allplan.com/de/faqid/20101004223723.html

Warning: The graphics board 'XXX' causes problems.
-> The graphics engine does not work with this card. Allplan runs in "GDI+" mode. large volumes of data considerably slow down the performance of the computer.
Allplan Connect also helps you determine whether a specific graphics card can be used (see above).
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			Question:

Reinforcement views are no longer available as of Allplan 2023. How can I continue to use the data from the reinforcement views module from Allplan 2023?


Answer:

As of Allplan 2023, there are important changes regarding the old reinforcement views, these are no longer available as of this version.

Your data that you have drawn with the reinforcement views will then be automatically converted into 2D elements.

Therefore we recommend to wait with the installation of the 2023 until you have finished these projects, or to make a mandatory backup of your projects, offices and user data in the older version before installing the "upgrade".

Please consider carefully for your further project handling whether a project that is still being processed should be processed in the Allplan 2023 version or higher, or whether this should be completed in Allplan 2022 for the aforementioned reasons.


Conversion of the data in version 2023 and higher.

The data with reinforcement views from versions up to 2022 are automatically converted the first time the project is opened or when *.ndw files are opened for the first time.

The plan layout of the formwork or reinforcement plans is retained!
The 3D model of the reinforcement is retained!
The reinforcement views (and also the reinforcement shown in them) are converted into 2D constructions and texts.

Further processing of the data:

Since the reinforcement remains as a 3D model, it is possible to derive new views and sections from this model data again after the drawing file has been converted.

The reinforcement can be further placed, modified and labelled. Schemas, legends or reports are generated as before.
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			Question:

What can I do if Allplan does not start?


Answer:


Work through the following steps:

Step 1 - run as administrator
Start Allplan with the ‘Run as administrator’ option.
To do this, right-click the Allplan icon and click ‘Run as administrator’.
If Allplan does not start, go to step 2.

Step 2 - cleanup
Allplan is not running. Start the Services application and do the following:
Services application -> Service -> Hotline Tools -> cleanup -> OK
If Allplan does not start, go to step 3.

Step 3 - cleanstd
Allplan is not running. Start the Services application and do the following:
Services application -> Service -> Hotline Tools -> cleanstd: reset CAD defaults -> OK -> OK -> Yes -> OK
If Allplan does not start, restore the settings:
Services application -> Service -> Hotline Tools -> laststd: restore the last settings -> OK -> OK -> Yes -> OK
Go to step 4.

Step 4 - cleanreg
Allplan is not running. Start the Services application and do the following:
Services application -> Service -> Hotline Tools -> cleanreg: reset CAD registry settings -> OK -> OK -> Yes -> OK
If Allplan does not start, restore the registry settings:
Services application -> Service -> Hotline Tools -> lastreg:restore most recent CAD registry settings -> OK -> OK -> Yes -> OK
Go to step 5.

Step 5 (Allplan 2016 and later)
Restart the Wibu service:
Start CodeMeter Control Center.
To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen and enter Codemeter.

CodeMeter Control Center -> Process -> Start CodeMeter Service
If the service is running, stop it and restart it. 
[image: ]

If Allplan does not start, go to step 6.

Step 6 (Allplan 2016 and later)
Go to the Wibu website and install CodeMeter User Runtime Version for Windows (64-bit version).
You can find the installation program at https://www.wibu.com/de/anwendersoftware.htmlor on the Nemetschek FTP server ftp://nemhotline:ha37jvg8f@ftp.nemetschek.deat download/General/Wibu/CodemeterRuntime.exe

Start the ‘CodeMeterRuntime.exe’ file.
To do this, right-click this file and select
‘Run as administrator’.
Confirm all messages displayed and the defaults by clicking ‘Next’.
CodeMeter Control Center will be installed afterwards.
If Allplan does not start, go to step 7.

Step 7 - contact Technical Support
Send the following information by email to support.de@allplan.com:
	An exact description of the last step before the error or crash occurred.
	The error message itself (as a screenshot). To find out how to take a screenshot, look at
https://connect.allplan.com/en/faqid/0001cb36.html
	A support request (Hotinfo) with question 01. To find out how to create a support request, look at
https://connect.allplan.com/en/faqid/20140528094911.html
	The 'Allplan.out' log file. To find out how to create a support request, look at
https://connect.allplan.com/en/faqid/0001a27a.html
	Allplan 2016 and later -> a screenshot of the Wibu Control Center. To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen and enter Codemeter. 



We will contact you.



			
		

	




		
			








	
		
			
				
					
					Resetting Windows printer drivers in Allplan
				

				

			


			

				
					
						  Link
					
					

					
					

				

			

		

	


	

		
			
				
					Version: 
					Allplan 2016, Allplan 2021, Allplan 2020, Allplan 2018, Allplan 2017, Allplan 2019, Allplan 2015, Allplan 2013, Allplan 2014

				
				
				 | Last modified: 27.02.2024 14:00
				
			

			
				
						 

							
								
							

						 rate

						

					
			

		

		
			

			Problem:

Printing with Windows printer drivers is only possible in a restricted way or not possible at all. 



Solution:

Resetting all the files with the default values in question involves several steps.
Work through these steps one after the other and check whether the problem is solved after each step.

Step 1

Check whether you can print a test page.
Start -> Control Panel -> Devices and Printers -> select the printer  -> Printer properties  -> General tab -> Print Test Page.

If you can print the test page but you still cannot print from Allplan -> step 2.

Step 2

Carry out the cleanprint hotline tool.
Exit Allplan, start the Services application and do the following:
Services application -> Service -> Hotline Tools -> cleanprint -> OK

If the problem still occurs -> step 3

Step 3

Reset the plastw.dat file.
Exit Allplan, start the Services application and do the following:
Service -> Hotline Tools -> cleanstd: resets CAD defaults -> OK
Information is displayed. Confirm it by clickingOK. 
question: would you like to reset all CAD settings? It is essentialthat you clickNo.
A dialog box with a list is displayed. Select the plastw.dat file and confirm by clicking OK.

Now it should be possible to print without any problem.



Note:

You can find up-to-date printer drivers provided by the printers' manufacturers on the Internet. 
If you have problems with the printer, please download the current driver and install it.

Hewlett Packard:  http://www.hp.com
Epson:   http://www.epson.de
Océ:   http://www.oce.de
Canon:    http://www.canon.de
Brother:   http://www.brother.de
Lexmark:  http://www.lexmark.de
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			Question:

How can I use a license server license outside the office (for example, when working with my own computer from home)?



Answer:

Computers that are not on the company network must use a VPN connection to access the server.
You can get licenses from the license server directly over the network or VPN.

Note the following points when you use VPN:
Communication with the license server is by TCP/IP via port 22350.
Make sure that the VPN connection does not switch to sleep mode. Otherwise, it is better to borrow a license by using VPN instead of getting the license directly from the server.
You can use only iPv4 for the VPN connection; iPv6 is not supported by Allplan.
The firewall must be configured on both sides - client and server - so that the connection is allowed. Otherwise, add the port as an exception to the firewall.

Allplan automatically finds the license server on the local network. If you have not selected a license, Allplan automatically selects the first available license.

After having installed Allplan on the clients, you can use the “License Settings” dialog box to configure license selection.
Services application -> Utilities -> License settings
License selection
Find license server automatically: 
When you select this option, Allplan automatically detects a license server on the LAN. In some cases, such as VPN connections, Allplan might not be able to detect a server automatically. In this case, you can enter the server manually (see Additional server name).
Note: Only the Windows administrator can change this option.

Additional server name: 
If “Find license server automatically” is not selected or Allplan has not automatically found a license server, you can manually enter the name or the IP address of the server. Enter only the name or the IP address of the server; do not enter a UNC path. After having entered the server name, click “Update” to see the licenses of the license server. Use semicolons to separate several server names.

If the license is visible and the connection is stable, you can get the license directly from the server when you start Allplan. If the connection is not stable, we recommend that you borrow a license. To get instructions, use the following link:
https://connect.allplan.com/en/faqid/20160523165423.html


Note:
VPN is not useful for common project storage, but you can use VPN to get a license.



			
		

	




		
			








	
		
			
				
					
					Hotletter 2021
				

				

			


			

				
					
						  Link
					
					

					
					

				

			

		

	


	

		
			
				
					Version: 
					Allplan 2021

				
				
				 | Last modified: 28.02.2024 08:03
				
			

			
				
						 

							
								
							

						 rate

						

					
			

		

		
			

			Information:

This document provides additional information on installing Allplan 2021.

Data backup/archiving:

We strongly recommend that you perform a complete data backup and archive this data before you upgrade to Allplan 2021!


Installation Instructions:


Detailed installation instructions can be found in the following places:

- If you have downloaded and unpacked Allplan 2021, you will find the file install.chm in the folder C:\Users\Public\Documents\Allplan 2021\HelpFiles\English


Please read these before installing Allplan 2021.

System requirements Allplan 2021

https://connect.allplan.com/de/faqid/20200930085615.html

Licenses when upgrading to Allplan 2021

https://connect.allplan.com/en/faqid/20200821110044.html


Extract from the installation instructions (see above)

If you want to switch from Allplan 2018/2019/2020 to Allplan 2021, you have three basic installation options. 

1. New installation

Allplan 2021 is installed in a new folder. Any existing installations of Allplan (2020 or older) are not affected. No data and settings are transferred to the new installation.

The following options are available for transferring data later:

Uninstall Allplan 2021 and then upgrade Allplan 2018/2019/2020.
Integrating the data by hand (administrator knowledge required).

2. New installation with data copy from version

Allplan 2021 is installed in a new folder. Any existing installations of Allplan (2020 or older) are not affected. The office standard (\std), projects (\prj) and user data (\usr) can be automatically copied from an existing version 2018/2019/2020 to the new installation folder.
In this way, you can create a duplicate dataset if necessary: all projects, standards and resources can be used in both Allplan 2021 and 2018/2019/2020. This allows you to test the transition to the new version in real life, while the existing Allplan installation remains fully functional. 
Note, however, that this method of working should avoid parallel processing of data in both installations, as the subsequent merging is time-consuming.

2a. Continuation of new installation with data copy from version

This option is available if a new installation with data copy has already been performed on another computer accessing the same data server and therefore the data has already been transferred.

3. Upgrade with data transfer from version 2018/2019/2020

Allplan 2021 is installed in an existing folder. The existing installation of Allplan 2018/2019/2020 is converted to Allplan 2021 and all important settings are transferred (see also Limitations for Data Transfer). Allplan 2018/2019/2020 is then no longer available.
Any existing installations older than Allplan 2018 are not affected.


Network Installations:

For network installations (shared 'central file storage folder'), only one main release version can be used - all workstations must be brought to Allplan 2021. Before starting the installation, make sure that all workstations have upgrade authorization. A mixed installation of different main versions is not technically approved. Complications that may arise are not covered by the maintenance contracts.

During the upgrade, no workstation may be running any version 2020, 2019 or 2018.

In case of an installation with Workgroupmanager all workstations must be checked in during the upgrade.




Data Conversion:

Data from older Allplan versions must be converted to version 2021. This happens automatically for projects opened in Allplan 2021. For instructions on how to convert all projects at once, click here: 

https://connect.allplan.com/de/faqid/20090408124904.html
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			Question:

What license issues do I need to consider when upgrading from Allplan 2020/2021/2022 to Allplan 2023?

Answer:

Installation options during Setups

Upgrade - program update with transfer of all project data, office and user settings.
The existing Allplan installation is upgraded to version 2023. If several Allplan versions are installed, only the latest version will be suggested for upgrade.  Projects, office and user settings are automatically transferred from 2020/2021/2022 to Allplan 2023. Allplan 2020/2021/2022 is then no longer available.

New installation without transfer of project data, office and user settings:
Existing Allplan installations remain unchanged. Office and user settings are not transferred to version 2023. You can import projects after installation using the following Allplan function: 
New project, open-> Import projects.

New installation with transfer of office and user settings:
Existing Allplan installations remain unchanged. Office and user settings are automatically transferred from 2020/2021/2022 to version 2023. In the case of multiple installed Allplan versions, only the most current version is suggested for transfer. If you have installed with a central file store, make sure that you create a folder with a suitable share on your central file store (server) beforehand. This folder can then be selected as the "central file storage folder" during setup. You can import projects after installation with the following Allplan function: 
Project new, open-> Import projects.



Depending on the licensing system you use, you need to consider different points.

There is no license request when installing Allplan 2023. Therefore, make sure in advance that your licenses are also suitable for this version, e.g. by purchase or a valid service contract.


1. Upgrade Allplan 2023 – stand-alone workstation 

Your license for Allplan 2023 will be updated after installation, when you start Allplan 2023 for the first time. Start Allplan 2023 and you will be prompted to update the license. Select "Update now" here. The license is updated online. You can then start Allplan 2023 directly or close the license window. 

Note: To install Allplan 2023 on a new computer, please read on connect.allplan.com/license within the menu item Information on Installation and Licensing the instructions Transferring license to a new computer.

You can find your Product Key in Allplan Connect as usual. Go to: connect.allplan.com/license 

2. Upgrading Allplan 2023 with a license server 

Start by updating your license(s) at the license server. After this, upgrade the clients. To do this, start the License Settings program on the server. Click License Activation on the left, and then click the license you want to update. Click Update License.
After the license(s) update, you can perform the Allplan upgrade installation on the client computers.

NOTE: Check the version of your installed license server on the server. Starting with the license server version 2016-1-4, the detailed version status (Build-ID) is displayed directly in the lower left corner of the License Settings program.
At least version 1.1196.xxx.xxx should be displayed here. If an older Build ID is displayed, then you still have an older license server in use. In any case, please update your license server. Download the software for the license server from the Allplan Connect service portal. Detailed instructions can be found at connect.allplan.com/license under the menu item Information on installation and Licensing' and the instructions 'Updating license server and licenses'.


Note: You can update the licenses only at a license server you have already installed. If you want to switch to Allplan 2023 and move the license server to a new server, please read on connect.allplan.com/license within the menu item Information on Installation and Licensing the instructions Moving license server to a new server.

You can find your Product Key in Allplan Connect as usual. Go to: connect.allplan.com/license


Downloading licenses from Allplan Connect 
You can also obtain your activation codes for Allplan 2022 IBD in the Allplan Connect service portal.
To do this, click Profile > License Management. 
You can only use this function as an administrator.
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			Question:

I purchased the license server. How can I install and configure the license server?



Answer:

Allplan is using since version 2016 a new protection system. Licensing is based on CodeMeter by Wibu Systems AG since then. You can no longer use NemSLock Server with Allplan 2016 and higher.
Allplan requires a Product Key. Using this key, you can activate your license online. The Product Key is a unique, 26-digit character string. You can use it to activate a license for Allplan.
You can find your Product Key in Allplan Connect. Go to http://connect.allplan.com/license
Note: The license is downwards compatible til version Allplan 2016-1-4 even if a higher version is displayed.


To install the license server, download the software for the license server from Allplan Connect 


The Wibu license server is part of the CodeMeter driver, which is installed along with Allplan. If you have already installed Allplan on the license server, you do not have to install additional software. But you can also install the license server separately; you do not have to install Allplan.
In any case, install and activate the license server before you install Allplan on the clients.

You can activate a license in online mode only if you have ...
	Internet access
	a Product Key
	a license server license; you cannot use other licenses with the license server.




Installing the license server

	You must install the license server on a 64-bit Windows system.
	Start License Server Setup on the computer you want to use as the license server.
	Click Install.
	Start the license server by starting the License Settings program. Go to the License activation area, enter your Product Key and click Activate license.
	If you have more licenses for the license server, enter the respective Product Keys and activate the licenses.
	Afterwards, start CodeMeter Control Center.

To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen: enter Codemeter and press ENTER. A dialog box opens. Click WebAdmin at bottom right.

Or
Enter Localhost:22350in the address bar of your browser.

	Select Configuration -> Server -> Access server in the Network server area and click Activate.
	Click Apply.



Configuring the license server (optional)

You can use the CodeMeter WebAdmin application to administer the license server.
To start and stop the license server service, you can use CodeMeter Control Center.
	CodeMeter Control Center -> Action -> Start or Stop CodeMeter Service


Access control
By default, all users on the LAN, who have installed the CodeMeter driver, can use a license from the license server.
	Basic access control: you can enter a list of client computer names or IP addresses that are allowed to access the license server.
	Advanced access control: you can specify global access rules (for all licenses) to control access to the licenses.


License tracking
To activate license tracking, you have to set the HKEY_LOCAL_MACHINE\SOFTWARE\WIBU-SYSTEMS\CodeMeter\Server\CurrentVersion\LogLicenseTracking registry entry to 1 and restart CodeMeter Service.

After having activated this key, you can use CodeMeter WebAdmin to create a report showing details about the licenses used over a specific period of time. To do this, open CodeMeter WebAdmin and go to the 'Server' - 'License Tracking' page. Select the period of time and the license for which you want to generate a report. Then click 'Create report'. If you click a single bar, you will get detailed analyses per day or per hour.

CodeMeter WebAdmin saves the reports to C:\ProgramData\CodeMeter\Logs.



Installing and configuring clients

Usually the license server license will be detected automatically in the network. 
Install Allplan on the clients. There is no license druing setup necessary.
Follow the installation instructions.

	You do not need to activate the clients. 


Allplan automatically finds the license server on the local network. If you have not selected a license, Allplan automatically selects the first available license. 

After having installed Allplan on the clients, you can use the 'License Settings' dialog boxto check and configure license selection.
Services application -> Utilities -> License settings

Areas:
	License activation: this area is not relevant to clients taking their license from the license server.
	License selection: use this section if you get the license from a license server or if you have several licenses and you want to select the preferred license.
	Start as a viewer: click this button if you want to start Allplan as a viewer.



License selection

You can see the names of the available licenses with their seat numbers. 
The 'Available' column indicates how many licenses are still available. Click the dropdown arrow to see a list of users currently working with a license.

Priority: 
Select the check box in front of a license to select this license as a favorite. You can mark as many licenses as you want. Allplan will then prefer these licenses. Click [image: ]
to select one ore more licenses Allplan is not to use. If you do not select any license or if you have selected several favorites, Allplan will automatically use the first free license it finds.

Find license server automatically: 
When you select this option, Allplan automatically detects a license server on the LAN. In some cases, such as VPN connections, Allplan may not be able to detect a server automatically. In this case, you can enter the server manually (see Additional server name).
Note: Only the Windows administrator can change this option.

Additional server name: 
If 'Find license server automatically' is not active or Allplan has not automatically found a license server, you can manually enter the name or the IP address of the server. If 'Find license server automatically' is active, you can enter an additional server. After having entered the server name, click 'Update' to see the licenses of the license server. Use semicolons to separate several server names.


Note: 

You can find detailed information on the license server in the License Settings help (F1 key).

Allplan communicates with the license server via TCP/IP. By default, communication is via Port 22350 unless you change the port in CodeMeter WebAdmin.
If a firewall is active on your computer, you must enable port 22350 for TCP and UDP. If the firewall filters in an application-specific manner, you have to enable the CodeMeter.exe license server service. You can find this service in the %Program Files (x86)%\CodeMeter\Runtime\bin Windows folder. Define the CodeMeter.exe service as an exception in the firewall. Some anti-virus programs also include firewall functions. If you are not sure, contact the manufacturer of the anti-virus program.
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			Question:

You get an error message at program start that the UID(xx) of the new user is greater than the current maximum UID(xx). How can you increase the maximum number?


Answer:

By default, Allplan with Workgroupmanager can manage a maximum of 128 CAD users. 
However, since version 2008, it has been possible to increase the number of Workgroupmanager users to up to 992 CAD users.
To do this, you need to create the file nemusers.cfg in the Net folder of Allplan's central file storage. 
You can see the path of the central file storage in the Allmenu/Service Application window. 

If the file with the name "nemusers.cfg" exist (the file type does not matter) already, then the value noted in the file is important.
In this case, check the entered value and increase it in 32 steps up to max. 992.

If the file does not exist, create this file, open it and enter a value in 32 steps e.g. 128, 160 or 192...
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			Question:

How is a silent installation of Allplan from version 2024 carried out?

Answer:

Allplan has been installed using the Windows Installer since version 2022.
The Windows Installer has a number of advantages such as repairability and providing installation on a network. Allplan can also be installed unattended (“quiet”) using the Windows Installer.

Please note that no individual support can be provided for this procedure.
If you are unsure, ideally have your IT service provider or administrator carry out these instructions.

The following steps are necessary:

1. Edit the settings file
The settings file attached to this FAQ must be edited in advance in order to select the desired program components.
Here is a description of the structure of the settings.txt file:

· Installation options:
Set the desired installation option:

New installation:
No data is transferred from the most current previous version.
Value to be entered:
Upgrade=Upgrade.UpgradeNew
 
New installation with data copy:
Allplan is installed parallel to the previous version and the data (with the exception of the projects) is copied. Projects can be transferred to Allplan itself after the installation has been completed.
Value to be entered:
Upgrade=Upgrade.UpgradeKeep
 
Upgrade:
The latest available Allplan version will be converted into the current version.
Upgrade=Upgrade.Upgrade
 
· Paths:
Enter the desired program folder under "InstallPath" and the desired central file storage folder for Allplan under "CentralPath",
When storing data in a network, be sure to use the CentralPath in UNC notation.

Example:
InstallPath=C:\Program Files\Nemetschek\Allplan_2024
CentralPath=\\SERVER\CAD_Daten\Allplan\Allplan_2024

Important:
In the case of an upgrade, be sure to specify the path of the previous version for "CentralPath".


· Countries and languages:
Select the countries and languages to install from the list of suggestions in the file.
Set the main country with "DefaultCountry" and the main language of the installation with "DefaultLanguage".
Add additional countries and/or languages if desired.
Wichtig: For a functional installation, the main country and language must be specified.

Example:
# Country list: AUS AUT BEL BRA BUL CAN CHN DEU ENG FRA GRC HOL HRV ITA JPN KOR POL PRT RUM RUS SLK SPA SVN SWI TCH TRK UNG USA VNM YUG
# Language list: BUL CHN DEU ENG FRA GRC HOL HRV ITA JPN POL PRT RUM RUS SER SLK SPA SVN TCH TRK UNG VIE
DefaultCountry=DEU
DefaultLanguage=DEU
Country.ITA
Language.ITA
Language.ENG

· Advanced features:
Select the features or data you want to install from the list of suggestions in the file.

Example:
# Feature list: ProgramFiles AutoCon Desktop HelpFiles TextureFiles
Feature.ProgramFiles
Feature.AutoCon
Feature.Desktop
Feature.HelpFiles
Feature.TextureFiles
Feature.Demos

· Manufacturer-specific user data:
From the suggestion list in the file, select the user data (product catalogs for reinforcement or formwork catalogs) that should be installed.

Example:
# Vendor list: Ancon Ancotech Armaturis Lindab BarSplice Coupler DaytonSuperior Bartec Rolltec Erico Filigran Halfendeha Halfenhbs Hrc Line Register Peikko Philipp Reidbar Sah Schoeck Splice
Vendor.Ancon
Vendor.Ancotech
Vendor.Armaturis
Vendor.Lindab
Vendor.BarSplice
Vendor.Coupler
Vendor.DaytonSuperior
Vendor.Bartec
Vendor.Rolltec
Vendor.Erico
Vendor.Filigran
Vendor.Halfendeha
Vendor.Halfenhbs
Vendor.Hrc
Vendor.Leitungskataster
Vendor.Peikko
Vendor.Philipp
Vendor.Reidbar
Vendor.Sah
Vendor.Schoeck
Vendor.Splice

# Formwork: Meva1
Formwork.Meva1

2. Storage of the installation and the settings file on a share (optional)
In order to be able to roll out the Allplan installation efficiently on all computers, it is recommended to store both the Allplan setup and the settings file on a share in the network to which all relevant computers have access. See also the note on the full setup at the end of the FAQ.

3. Choice of installation option
You can choose between the following installation options:

· Quiet Installation: Installation takes place without user input being necessary.
· Passive installation: Installation takes place with reduced user input.

4. Installation
The installation is started in the unpacked 'Allplan' folder using the file 'Allplan_Installer.exe' using the following command line entries:

· For quiet installation:
Allplan_installer.exe /Settings <path to the settings file> /quiet

Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /quiet

· For passive installation:
Allplan_Installer.exe /Settings <path to the settings file> /passive

Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /passive
 
5. Modify the installation
It is also possible to modify the installation.
To do this, edit the settings file for the desired additional or components to be removed. Call the setup with the following parameters:

· For quiet installation:
Allplan_Installer.exe /Settings <path to the settings file> /quiet /modify

Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /quiet /modify

· For passive installation:
Allplan_Installer.exe /Settings <path to the settings file> /passive /modify

Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /passive /modify
 
6. Repair of the installation
It is also possible to repair the installation.
Call the setup with the following parameters:

· For quiet installation:
Allplan_Installer.exe /Settings <path to the settings file> /quiet /repair

Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /quiet /repair

· For passive installation:
Allplan_Installer.exe /Settings <path to the settings file> /passive /modify

Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /passive /repair
 
7. Uninstall
Uninstallation can also be done via passive or quiet installation.
 
Rufen Sie das Setup mit folgenden Parametern auf:
 
· For quiet installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /quiet /uninstall
 
Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /quiet /uninstall
 
· For passive installation:
Allplan_Installer.exe /Settings <Pfad-zur-Settings-Datei> /passive /uninstall
 
Example:
\\SERVER\Share\Subfolder\Allplan_Installer.exe /settings \\SERVER\Share\Subfolder\settings.txt /passive /uninstall


HInt:
Of course, in the silent setup, the name of "Allplan_Installer.exe" must be adapted to the name that matches the version (e.g. Allplan_2023_0_4_Installer.exe).


Note on downloading the full setup from version 2023:
From version 2023 onwards, Allplan is installed using a minimal installer, which only downloads those components that are actually required for the installation.
If, for example, the complete installation package with all optional components is required to roll out the setup, it can be downloaded using the layout mode, which is described in the following FAQ. 

https://connect.allplan.com/de/faqid/sc-000007942.html

 
Note on licensing:
Since there is no longer a license query in Allplan Setup from version 2022, this information cannot be provided. If a license server is in use, it can be set up on a computer and then distributed using the following procedure.

https://connect.allplan.com/de/faqid/sc-000007100.html
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			Question:

How can I restore a lost building structure or layout structure?



Answer:

To restore a lost or corrupt building structure or layout structure, you can do the following:

	Close Allplan.

	Open Windows Explorer, go to the central file storage folder of Allplan and open the "Prj"folder. Open the corresponding project folder and the "BIM" subfolder.

Note:
If the "Same folder name as project name" option is not selected for the project, a number is used for the folder name in the "Prj"folder. In this case, open the Services applicationand select the woprohotline tool (Services application -> Service -> Hotline Tools -> wopro). Select the corresponding project by double-clicking its name. An information dialog box shows the folder and file name of the project.

	You can find an XML file for each structure in the BIM subfolder.


Building structure:
Allplan_BIM_BuildingStructure.xml

Objects derived from building structure:
Allplan_BIM_Views.xml

Plane model:
Allplan_BIM_LevMo_"name of model".xml

Layout structure:
Allplan_BIM_LayoutStructure.xml


	To restore the building structure from a backup, rename the existing file "Allplan_BIM_BuildingStructure.xml" "Allplan_BIM_BuildingStructure.xml.old", for example. 

	Switch to the "Backup"folder, which you can also find in the"BIM"folder.

	Select the most recent file that had been created beforethe building structure was deleted, for example, "Allplan_BIM_BuildingStructure.xml.27.5.2008--10-32-21.bak". The characters in bold indicate the date and time of the backup. Copy this file to the "BIM"folder.

	Rename this file by deleting the characters after ".xml". Now the file name is "Allplan_BIM_BuildingStructure.xml".

	Restart Allplan. The last version of the building structure is displayed in the "Open on a project-specific basis"dialog box again.




Note: 

Using Allplan 2009-2 and later, you can restore the layout structure from a *.bak file straight from the "Open on a project-specific basis: layouts"dialog box.

	Right-click the topmost structural level in the layout structure (project name) and select Load layout structure favoriteon the shortcut menu.

	Open the last version of the Allplan_BIM_LayoutStructure.xml file in the backup folder mentioned above.


If the *.bak files are not displayed, please follow the steps described above.
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			Question:

My projects in Allplan are suddenly incomplete, or projects are suddenly missing in the project list. What could be the reason for this?



Response:

Check whether the Windows synchronization is active. Sometimes it can happen that the synchronization was activated by a Windows update.
Then deactivate it again.

To do this, go to the Windows search and enter Control Panel.
Make sure that the Control Panel shows all items. To do this, go to Category at the top right of Display and select 'Small icons' or 'Large icons'.

In Control Panel, go to Synchronization Center ->click on left side Manage Offline Files. 
Here it should say under General - Enable Offline Files. 
If Disable Offline Files is displayed here, click on it and use it to disable synchronization. 
Then click on Apply. 
In order for the settings to be applied, you must now restart your computer.

Now test the behavior in Allplan again.  
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			Question:


How can the "central file storage folder" of an existing Allplan installation be moved to a new server?

General:

Before the changeover, make sure that a current data backup of the central file storage is available.
The data is not moved but copied during the changeover.
To avoid duplicate data storage, all workstations of the existing network installation should be migrated in this way. These instructions apply equally to installations with and without workgroup manager.


Answer: 
	Before the changeover, create a folder on the new server (e.g. Data) and share this folder with everyone with full access (e.g. as Data). Create a subfolder Allplan under it. (e.g. \\Server\Daten\Allplan).Allplan works with UNC path. This means that for a network installation, a folder must exist for the central file storage on which Allplan 2022 is to be installed, which is shared by all computers.
	Exit Allplan on all workstations.
	Open the Allplan Diagnostic Tool via Allmenu->Service->Allplan Diagnostics. There you switch to the tab "Settings"
	Under the "Workgroup Settings" field press "Browse". In the browser that appears, you can browse for the new share by entering the UNC name of the new server or the complete path at the top and confirming with Enter. Select your new central file storage folder and confirm with OK. Note that if you are using the Workgroup Manager, the new path must be entered in a UNC-compliant way only. (e.g.: \\Servername\ nemdata\2022)
	To start the changeover, press the "Set" button. The copy process starts and the configuration is changed. The data is not moved but copied and this workstation is now converted and accesses the new data store.

Note:

To avoid duplicate data storage, all workstations of the existing network installation should now be converted via the same path. For the other workstations, the copying process of the project and STD folder is prevented with a corresponding note, since the routine already recognizes these folders on the new server. only the configurations on the computer are changed.

Important note when using Workgroupmanager if data has been copied in advance via Explorer:

If you have already copied the data from the old server to the new one, only the path will be adjusted in the Diagnostic Tool, because the path already contains the relevant folders "prj" and "std" and "net". I.e. the important files which are relevant for the workgroup manager are not adapted and must be edited afterwards absolutely by hand!

Changes on the server
Enter the new server name in the following files on the new server. You can find these files in the NET folder, which is a subfolder of the central file storage folder. You can open the files in an editor and edit them there.

data.cfg
· Enter the server name in CAPITAL LETTERS (also applies to user.cfg and project.dat!), for example, SERVER.
· Do not delete the blanks after the server name.
· If the share name or folder name has changed, you need to enter the new name after the blanks.

user.cfg
· Since Allplan 2014 this file is encrypted and is saved in ANSI format
· Open the files with editor. After the = change the server name to new name, use CAPITAL LETTERS (without any blanks).
· When finished click on file in the left top and chose save file as
· File name: user.cfg
· File type: text file (*.txt)
· Encyryption(Coding): ANSI
· Save

Note: if the server name is not shown in user.cfg please contact us again by sending your fuser.cfg and the new server name.

project.dat
· Rename the "project.dat.xml" file "project.alt.xml".
· Then go to step "2. Changes on the workstations". Complete the process for one workstation!
· When you have finished, do the following:
Services application -> Service -> Hotline Tools -> reorg -> Restore project management file -> OK
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			Question:

Suddenly, one of the following error messages pops up: "This license is no longer available", "CmActLicense runtime system is not installed!" or "NemAll_DataResource20.dll: Start Error 102".  After this, Allplan does not start anymore. How can I solve this problem?


Answer:

The local Windows service, which is used by licensing, is not running correctly. 

If communication with the local Wibu service is blocked, Allplan cannot find the license anymore. This is often caused by the virus scanner.
So you need to exclude the "Codemeter" folder from virus scans. 
You can find this folders in the following path: 
C:\Program files (X86)\Codemeter 
C:\Program files\Codemeter 
C:\ProgramData\CodeMeter 

Then restart the service:

Start CodeMeter Control Center.
To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen and enter Codemeter. 

CodeMeter Control Center -> Process -> Start CodeMeter Service
If the service is running, stop it and restart it. 



Important note: 

Follow this link to find out how to configure the virus scanner in conjunction with real-time scanning. Exclude all Allplan folders with their subfolders from virus scans. You can display the paths to the Allplan folders in the Services application window. 

https://connect.allplan.com/en/faqid/20091126145752.html[image: ]
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			Frage:

Wie werden Grafikkartentreiber aktualisiert?



Antwort:

Je nachdem, welcher Hersteller die eingebaute Grafikkarte produziert, können Sie über die entsprechende Herstellerwebseite den aktuellen Grafikkartentreiber herunterladen und per Doppelklick installieren.

Hersteller und Modell werden wie folgt ermittelt:
	Mit Rechtsklick auf "Arbeitsplatz" bzw. "Computer" den Unterpunkt "Verwalten" auswählen
	In der Computerverwaltung rechts "Gerätemanager" anklicken, und den linken Unterpunkt "Grafikkarte" erweitern


Wenn die Modellnummer mit ATI beginnt, wechseln Sie bitte auf die Webseite des Herstellers AMD:
http://www.amd.com

Wenn die Modellnummer mit NVidia beginnt, wechseln Sie bitte auf die Webseite des Herstellers NVidia:
http://www.nvidia.de


Suchen Sie die entsprechende Verlinkung auf der Webseite zu den Treibern. Dort müssen Sie unter Angabe der Modellnummer und des Betriebssystems die entsprechenden Treiber auswählen, herunterladen und per Doppelklick installieren.

Bitte starten Sie nach der Installation der Grafikkarten-Treiber in jedem Fall Ihren Rechner neu!

Wählen Sie bei Grafikkarten von NVidia auf der Herstellerseite die Download-Option "NVIDIA Treiber automatisch erkennen lassen", um die korrekten Treiber automatisch suchen zu lassen.


Hinweise: 

Falls Sie einen Laptop einsetzen, ist es möglich, dass Sie vom Grafikkartenhersteller direkt auf die Webseite des Laptopherstellers weitergeleitet werden. Suchen Sie bitte in diesem Fall dort nach den aktuellen Treibern.

Falls Ihnen als Modellname "Chipset" angezeigt wird, besitzt Ihr Rechner eine On-Board-Grafikkarte. Diese integrierten Grafiklösungen sind für CAD-Programme wie Allplan ungeeignet.
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			Question:

I purchased the license server. How can I install and configure the license server?



Answer:

Allplan is using since version 2016 a new protection system. Licensing is based on CodeMeter by Wibu Systems AG since then. You can no longer use NemSLock Server with Allplan 2016 and higher.
Allplan requires a Product Key. Using this key, you can activate your license online. The Product Key is a unique, 26-digit character string. You can use it to activate a license for Allplan.
You can find your Product Key in Allplan Connect. Go to http://connect.allplan.com/license
Note: The license is downwards compatible til version Allplan 2016-1-4 even if a higher version is displayed.


To install the license server, download the software for the license server from Allplan Connect 


The Wibu license server is part of the CodeMeter driver, which is installed along with Allplan. If you have already installed Allplan on the license server, you do not have to install additional software. But you can also install the license server separately; you do not have to install Allplan.
In any case, install and activate the license server before you install Allplan on the clients.

You can activate a license in online mode only if you have ...
	Internet access
	a Product Key
	a license server license; you cannot use other licenses with the license server.




Installing the license server

	You must install the license server on a 64-bit Windows system.
	Start License Server Setup on the computer you want to use as the license server.
	Click Install.
	Start the license server by starting the License Settings program. Go to the License activation area, enter your Product Key and click Activate license.
	If you have more licenses for the license server, enter the respective Product Keys and activate the licenses.
	Afterwards, start CodeMeter Control Center.

To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen: enter Codemeter and press ENTER. A dialog box opens. Click WebAdmin at bottom right.

Or
Enter Localhost:22350in the address bar of your browser.

	Select Configuration -> Server -> Access server in the Network server area and click Activate.
	Click Apply.



Configuring the license server (optional)

You can use the CodeMeter WebAdmin application to administer the license server.
To start and stop the license server service, you can use CodeMeter Control Center.
	CodeMeter Control Center -> Action -> Start or Stop CodeMeter Service


Access control
By default, all users on the LAN, who have installed the CodeMeter driver, can use a license from the license server.
	Basic access control: you can enter a list of client computer names or IP addresses that are allowed to access the license server.
	Advanced access control: you can specify global access rules (for all licenses) to control access to the licenses.


License tracking
To activate license tracking, you have to set the HKEY_LOCAL_MACHINE\SOFTWARE\WIBU-SYSTEMS\CodeMeter\Server\CurrentVersion\LogLicenseTracking registry entry to 1 and restart CodeMeter Service.

After having activated this key, you can use CodeMeter WebAdmin to create a report showing details about the licenses used over a specific period of time. To do this, open CodeMeter WebAdmin and go to the 'Server' - 'License Tracking' page. Select the period of time and the license for which you want to generate a report. Then click 'Create report'. If you click a single bar, you will get detailed analyses per day or per hour.

CodeMeter WebAdmin saves the reports to C:\ProgramData\CodeMeter\Logs.



Installing and configuring clients

Note for Version 2016: Install at least Allplan 2016-1-4 on the clients. 

The license server license will be detected automatically on the network. 
Install Allplan on the clients. When you are prompted to select the license file, click Use active license. Follow the installation instructions.

	You do not need to activatethe clients. 


Allplan automatically finds the license server on the local network. If you have not selected a license, Allplan automatically selects the first available license. 

After having installed Allplan on the clients, you can use the 'License Settings' dialog boxto configure license selection.
Services application -> Utilities -> License settings

Areas:
	License activation: this area is not relevant to clients taking their license from the license server.
	License selection: use this section if you get the license from a license server or if you have several licenses and you want to select the preferred license.
	Start as a viewer: click this button if you want to start Allplan as a viewer.



License selection

You can see the names of the available licenses with their seat numbers. 
The 'Available' column indicates how many licenses are still available. Click the dropdown arrow to see a list of users currently working with a license.

Priority: 
Select the check box in front of a license to select this license as a favorite. You can mark as many licenses as you want. Allplan will then prefer these licenses. Click [image: ]
to select one ore more licenses Allplan is not to use. If you do not select any license or if you have selected several favorites, Allplan will automatically use the first free license it finds.

Find license server automatically: 
When you select this option, Allplan automatically detects a license server on the LAN. In some cases, such as VPN connections, Allplan may not be able to detect a server automatically. In this case, you can enter the server manually (see Additional server name).
Note: Only the Windows administrator can change this option.

Additional server name: 
If 'Find license server automatically' is not active or Allplan has not automatically found a license server, you can manually enter the name or the IP address of the server. If 'Find license server automatically' is active, you can enter an additional server. After having entered the server name, click 'Update' to see the licenses of the license server. Use semicolons to separate several server names.


Note: 

You can find detailed information on the license server in the License Settings help (F1 key).

Allplan communicates with the license server via TCP/IP. By default, communication is via Port 22350 unless you change the port in CodeMeter WebAdmin.
If a firewall is active on your computer, you must enable port 22350 for TCP and UDP. If the firewall filters in an application-specific manner, you have to enable the CodeMeter.exe license server service. You can find this service in the %Program Files (x86)%\CodeMeter\Runtime\bin Windows folder. Define the CodeMeter.exe service as an exception in the firewall. Some anti-virus programs also include firewall functions. If you are not sure, contact the manufacturer of the anti-virus program.
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			Question:

Allplan does not start. When you open license selection in the license settings, you can see the following message: "Cannot find a license for running Allplan." Sometimes you might also see one of the following error messages: "This license is no longer available", "CmActLicense runtime system is not installed!" or "NemAll_DataResource20.dll: Start Error 102". Allplan no longer starts after these messages. How to solve this problem?

Answer:

Check the following points:

On the client:

Open the license settings: Services application -> Utilities -> License settings

1. Has the license been blocked on the client?
Check the 'License selection' area to find out whether your license has been blocked. This is indicated by the  [image: ]
symbol. If the license is blocked, Allplan cannot use it.
Click this symbol to unblock the license again. If you want, you can select the check box in front of the license to select it as a favorite. Allplan will then prefer this license. 
If you do not select any license or if you have selected several favorites, Allplan will automatically use the first free license it finds.


2. Has the server been found?
Select the 'Find license server automatically' option. You should now see the license provided by the server.

Note: In some cases, such as VPN connections, Allplan may not be able to detect a server automatically. In this case, you can enter the server manually.


3. Is the local Windows service, which is used by licensing, running correctly? 

If communication with the local Wibu service is blocked, Allplan cannot find the license anymore. This is often caused by the virus scanner.
So you need to exclude the "Codemeter" folder from virus scans. You can find this folder in the following path: C:\Program files (X86)\Codemeter or C:\Programme (x86)\Codemeter 

Then restart the service:

Start CodeMeter Control Center.
To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen and enter Codemeter. 

CodeMeter Control Center -> Process -> Start CodeMeter Service
If the service is running, stop it and restart it. 


On the license server:

4. Is the 'Start network server' option active?
Start CodeMeter Control Center on the server.
To do this, use the Windows start menu and select CodeMeter -> CodeMeter Control Center. As an alternative, open Search by clicking the Search button on the Start screen, enter Codemeter and press ENTER. A dialog box opens. Click WebAdmin at bottom right.

Or
Enter Localhost:22350in the address bar of your browser.

	Select Settings -> Server -> Access serverin the Network serverarea and click Activate.



Update the license settings on the client. To do this, click Updateor open the dialog box with the license settings again. You should now see the license on the client. 


5. Restart the license server service on the server
To start and stop the license server service, you can use CodeMeter Control Center.
	CodeMeter Control Center -> Action -> Stop CodeMeter Service
	CodeMeter Control Center -> Action -> Start CodeMeter Service


Update the license settings on the client. To do this, open the dialog box with the license settings again. You should now see the license on the client.


6. Is the virus scanner blocking the Windows service, which is used by licensing, at the server?

If communication with the Wibu service is blocked, Allplan cannot find the license anymore. This is often caused by the virus scanner.
So you need to exclude the "Codemeter" folder from virus scans. 
You can find this folder in the following path: C:\Program files (X86)\Codemeter or C:\Programme (x86)\Codemeter 
In addition, exclude the C:\Program Files\Allplan GmbHfolder.

Then restart the license server service:
If the service is running, stop it and restart it. 


7. Check the firewall
Allplan communicates with the license server via TCP/IP. By default, communication is via port 22350 unless you change the port in CodeMeter WebAdmin. So you need to configure the firewall accordingly.

If a firewall is active on your computer, you must enable port 22350 for TCP and UDP. If the firewall filters in an application-specific manner, you have to enable the CodeMeter.exe license server service. You can find this service in the %Program Files (x86)%\CodeMeter\Runtime\bin Windows folder. Define the CodeMeter.exe service as an exception in the firewall. Some anti-virus programs also include firewall functions. If you are not sure, contact the manufacturer of the anti-virus program.
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			Question:

Why is Allplan running so slow?


Answer:

Check the following points:

1. Current version
Make sure you work with the current Allplan version.
	Do the following or ask your system administrator to do this:
Open Allplan and click the ‘?’ icon in the upper right-hand corner. Click ‘Update Allplan’.
Select 'Find now'. If Allplan finds updates or hotfixes, download the installation packages.

	Deactivate the virus scanner while your are installing updates or hotfixes. This might require administrator privileges. Contact your system administrator if you have problems.
	Right-click the Allplan icon on the desktop. A shortcut menu opens.
Select ‘Run as administrator’ and click ‘Yes’ to confirm the following message.
As a result, Windows security settings do not block the installation.



2. System requirements:
Check the hardware and software required for your Allplan computer.

2.a)Download and run the system test.
Check the notes.
https://www.allplan.com/de/system/systemvoraussetzungen/

2.b)Check the Allplan system requirements:
https://www.allplan.com/de/system/systemvoraussetzungen/

2.c)You can find information about graphics cards at
https://connect.allplan.com/de/support/grafikkarten.html

2.d)You can find server operating systems you can use for the central file storage of Allplan at
https://connect.allplan.com/en/faqid/20140924094923.html


3. Hotline tools:
Start the Services application, open the ‘Service’ menu and select ‘Hotline Tools’. To save your settings, select the following tools.

- savestd: Saves user defaults.
- savereg: Saves CAD registry settings.

Start the Services application, open the ‘Service’ menu and select the following ‘Hotline Tools’:

- cleanup: Initializes the display.
- cleanstd: Resets CAD defaults.
- cleanreg: Resets CAD registry settings.

Check whether this has solved the problems.
If this is not so, restore the settings you just saved. To do this, start the Services application, open the ‘Service’ menu and select the following ‘Hotline Tools’:
- reststd: Restores saved user defaults.
- restreg: Restores CAD registry settings.


4. Color scheme selected in Allplan:
Start Allplan, open the ‘View’ menu, point to ‘Toolbars’ and select ‘Customize User Interface’. Open the ‘Customize’ tab and set ‘Color scheme and icon design’ to ‘Windows’.


5. Check the availability of all projects that are not online (if you use Workgroup Manager):
Start Allplan, open the ‘File’ menu and select ‘New Project, Open Project’. Deactivate ‘Check availability of all offline projects’.


6. Virus scanner
Check whether an anti-virus program is running in the background of the computer or server.
If so, reduce protection to "programs only".

Scanning "all files" can take a long time, considerably slowing down your computer when you switch between projects or exit the program.
You can exclude the Allplan installation folders from real-time scanning.When you start the Services application, you can see a list of the folders to be excluded.
You can find more information at
https://connect.allplan.com/en/faqid/20091126145752.html
Changes in the settings of the virus scanner only come into effect when you re-start the computer.


7. Aero desktop effects
Deactivate the Aero desktop effects of Windows.
To do this, open the Control Panel, select ‘Ease of Access’ and go to the ‘Make things on the screen easier to see’ area.
Select the ‘Turn off all unnecessary animations (when possible)’ option.


8. Name resolution on the network
If Allplan takes several minutes to start, name resolution on the network may not work.
To check this, do the following:
Right-click the Windows Start Button, select ‘Run’, type in ‘cmd’, click OK, type in ‘Nslookup’ and press ENTER.
Go to the line following the > character, type in the name of the Allplan data server and press ENTER.
The reply starts with the name and address of the server providing name resolution.
You can find the name and address of the Allplan data server in the second group.
If problems occur, contact your network administrator and ask him or her to configure name resolution correctly.


9. Speed of Allplan projects
Check whether some Allplan projects are slower than other Allplan projects.
Start with the empty project and check whether it is slow too.
After this, select any other Allplan project.

If it is only the current project that is slow, the problem may be caused by the data of the current project.
In this case, the data of this project must be analyzed in detail.
Contact technical support.


10. Network: checking out Allplan using Workgroup Manager
If you use Allplan with Workgroup Manager, you can check whether the problems are caused by the network. To do this, check out the workstation with the project in question and use the project on the local Allplan workstation.
You can find detailed information on checking out an Allplan workstation using Workgroup Manager in the
Services application. Open the ‘Help’ and select ‘Workgroup Manager’.

After you have checked out the workstation, Allplan no longer accesses the central file storage of the server.
If this has solved the problems, they are caused by the network. In this case, the network must be checked in detail.
Contact your network administrator and ask him or her to do this.

If the project is still slow, the problem may be caused by the data of the current project.
In this case, the data of this project must be analyzed in detail.
Contact technical support.


11. Log files and system information files
If all the points above do not solve the problems, technical support requires more system information about the computer running Allplan.

	So, we would be grateful if you could send us a support request (Allplan Hotinfo with Allplan logging).
To create a support request, start the Services application, open the ‘Service’ menu and select ‘Create support request (Hotinfo)’.
Several dialog boxes open. Select ‘Technical Support Allplan’ and ‘Enquiry with Allplan logging’. Enter all the data required. Finally, click ‘Finish’.
Another dialog box opens, prompting you to start Allplan. Click the ‘Start Allplan’ button. 
Allplan starts, logging all processes. 
Try to reproduce the problem as exactly as possible.
Exit Allplan as soon as possible, reducing the data in the log file to a minimum.
Then click ‘Next’ to generate the support request with the log file. 
You can find more information about Hotinfo at
https://connect.allplan.com/en/faqid/20140528094911.html

	To analyze the Windows system environment, we would ask you to send us the logs created by Windows Event Viewer of your computer.
To start Windows Event Viewer, right-click the Windows Start Button, select ‘Run’ and type in ‘eventvwr.msc’.
You can also type in ‘Event Viewer’ in the search box of Windows. This displays the link file to the Windows event logs. 
Using Event Viewer, create *.evtx files for the application log and the system log in the ‘Windows Logs’ area and for the ‘Administrative Events’ log in the ‘Custom Views’ area.


Please send us the files.
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			Question:

I want to run Allplan on a terminal server. Can I use any other terminal server than Citrix?



Answer:

Microsoft terminal server or Horizon is not approved for Allplan.
In addition, running Allplan on a terminal server requires an Allplan license server for managing the Allplan licenses.
If you have only used stand-alone licenses until now, you must purchase the additional ‘license server’ option. Should you have any questions, please contact your sales partner.


VM Ware (Horizon) or RDP is not approved for Allplan. This means that you do not get any support for this constellation.
You may not have any problems with the current Allplan version. However, future developments will not take RDP or VM Ware into account. Consequently, this functionality may be limited or not available at all in future Allplan versions.

Citrix is the only terminal server that is approved for Allplan.
You can find information at
https://connect.allplan.com/de/support/sysinfohttps://www.allplan.com/de/system/systemvoraussetzungen/
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			Question:

You suddenly receive the error message "System requirements not met. CodeMeter is not installed. An update installation might fix the problem." How can this be fixed?


Answer:

The service required for licensing is no longer running correctly on your computer. 

Please proceed as follows on this computer:

In the first step, uninstall the existing components of Codemeter Runtime Kit. You will find the program in your Windows program list.

In the second step, install the Codemeter Runtime program again. 
You can download a current and released version of "Codemeter Control Center" from the following link.

https://webdrive.allplan.com/s/4LrjrymoxESzC6p

The program is located in the folder.
/General/Wibu/

(Click on the three dots to the right of the file size and select download)

Start the file "CodemeterRuntime.exe" bypassing the user account control. 
For installation, activate the file with the right mouse button and select in the context menu that is then available 
"Run as administrator".
Confirm all messages in the setup, as well as the settings made with 'Next'.
Codemeter Control Center will then be installed.


Note: 
We recommend excluding Codemeter from the virus scanner. You can get information about this at the following link:
https://connect.allplan.com/de/faqid/20151209133620.html
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			Question: 

A new computer is to replace the existing one.
How can I transfer the existing data and settings of the existing Allplan installation to the new computer?



Solution:

Please note that this solution only works with stand-alone versions.
Install the same version of Allplan on the new computer and transfer the data as follows:

1st - transferring the data:
Transfer the following folders from the old computer to the new one:
Project folder (PRJ)
Office standard folder (STD) and 
User folder (USR)

You can determine the path to these folders on both the new computer and the old computer as follows:
Services application->Service->Hotline Tools->Showcfg: shows system variables ->OK 
You can find the paths to the folders after PRJ, STD and USR.

2nd -  transferring the toolbar configuration:
Export the configurations from the old computer by clicking View -> Toolbars -> Customize... -> Export...
You can then import the configurations to the new computer by clicking View -> Toolbars -> Customize... -> Import...
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